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Currently the electrification ratio in Banyumas Regency is around 79%. This means, of the 1.7 

million residents of Banyumas Regency, only around 21% have not enjoyed PLN electricity. 

Those whose homes have not yet had electricity are on average residents who are on the slopes 

of the mountain slopes, and some residents in several groves in remote areas in Banyumas 

Regency which are very far from the PLN electricity network. This problem can be overcome 

by providing electrical energy by utilizing renewable alternative energy, one of which is micro 

hydro or pico hydro power plants on an individual or residential scale. Therefore, this research 

designed a simulation of a pico hydro power plant using a Pelton turbine which is expected to 

be able to provide benefits to the general public, this tool is equipped with remote monitoring 

using Google Firebase based on the Internet of Things which can be monitored via the Android 

application for monitoring Voltage, current and power use the INA219 sensor which has been 

programmed on Arduino Uno and Node MCU ESP8266. This tool uses a 12-24 Volt DC 

generator, produces DC electricity which is stored in a 12 Volt 5 Ah battery which is then 

converted using an inverter to become AC electricity. In this test using a 5 Watt AC lamp load, 

the battery voltage which was initially 12.6 Volts was reduced to 9.9 Volts, the lamp load was 

able to light up for 1 hour. In measuring the voltage and current, the generator produces an 

average voltage of 15.9 Volts and a current of 50.2 mA. 
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INTRODUCTION 

In Indonesia, the potential for micro-hydro hydro power has not 

been optimally utilized, while for remote areas power plants with 

micro-hydro power plants (micro-hydro power plants) are still 

more profitable than connecting these areas with the PLN 

network which is far away. With Indonesia's geographical 

condition which has the potential for water with adequate head 

for small-scale power plants, it is very potential to develop small-

scale power generation technologies commonly known as micro-

hydro power plants (PLTMH) and pico-hydro. This PLTMH 

technology continues to be developed both in terms of equipment 

and in terms of efficiency [1]. Currently the electrification ratio 

(RE) in Banyumas Regency is around 79 percent. This means that 

of the 1.7 million residents of Banyumas Regency, around 21 

percent do not enjoy PLN electricity. Those whose homes have 

not yet had electricity are on average residents who are on the 

slopes of the mountain slopes, and some residents in several 

groves in remote areas in Banyumas Regency which are very far 

from the PLN electricity grid. This problem can be overcome by 

providing electrical energy by utilizing renewable alternative 

energy, one of which is PLTMH [2]. 

 

Micro-hydro utilizes the potential energy of falling water (head). 

The higher the water fall, the greater the potential energy of water 

that can be converted into electrical energy. The relatively small 

amount of energy produced by micro-hydro compared to large-

scale hydropower plants has implications for the relatively simple 

equipment and the small area required for micro-hydro 

installation and operation. Thus, the micro-hydro generation 

system is suitable for reaching the availability of electrical energy 

networks in remote and rural areas. Some of the advantages found 

in micro hydro power plants are as follows: 

• Compared to other types of generators, this PLTMH is 

quite cheap because it uses natural energy 

• It has simple construction and can be operated in 

remote areas by skilled local residents with little 

training. 

• Does not cause pollution. 

• Can be combined with other programs such as 

irrigation and fisheries. 

• Can encourage the community to be able to maintain 

forest sustainability so that the availability of water is 

guaranteed. 

 

Based on this background, a solution is needed to increase the 

electrification ratio (RE) for residents whose homes have not yet 

been electrified, the large number of residents who are on the 

slopes of the mountain will have an abundance of natural 

resources from mountain water flow, so it has great potential to 

be developed as a pico-hydro hydroelectric power plant, namely 

http://ajeeet.ft.unand.ac.id/
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By utilizing the surrounding water flow to be used as a pico-hydro 

power plant, this pico-hydro power plant is very suitable for use 

by individuals who can meet their daily needs because the 

construction is cheap and easy to find. to be equipped with 

sensors for remote monitoring which is very time-efficient due to 

the many activities that must be carried out by the community in 

their daily needs. 

 

Pico hydro Power Plant is the term used for power plant 

installations that use water energy. The condition of water that 

can be utilized as a source of electricity has a certain flow capacity 

and height from the installation. The greater the flow capacity and 

the height of the installation, the greater the energy that can be 

used to produce electrical energy.  Hydroelectric power plants are 

distinguished by: 

1. Large hydro : More than 100 MW 

2. Medium hydro : Between 15–100 MW 

3. Small hydro : Between 1–15 MW 

4. Mini hydro: Power above 100 kW, but below 1 MW 

5. Micro hydro : Between 5kW–100 kW 

6. Pico hydro: The power released is 5kW 

 

In 2013 there was a study that discussed monitoring of Micro 

Hydro Power Plants (PLTMH). The only electrical parameters 

that are monitored are the amount of voltage, current, and 

rotational speed generated and can be accessed via access points 

from wifi [3]. As for other studies that test how much electrical 

energy is generated in the difference in the rotation of the water 

currents. Using a mini water pump as a source of sending water 

to the turbine by changing the jet of water produced through the 

sprayer gun as a water flow rectifier, by changing the rotation of 

the sprayer gun between the initial spray positions of 10 cm, 

medium 2 cm, and low 4 cm. The lowest voltage is found in the 

sprayer gun rotation at the 4cm rotation position, which is 27.90 

Volt. The medium voltage obtained at the 2 cm rotation position 

is equal to 39.50 Volt and the highest voltage is found in the 

sprayer gun rotation at the initial rotation position of 0 cm which 

is equal to 40.25 Volt [4]. 

 

One of the advanced technologies today is IoT. Basically, IoT 

technology has been found since the 1990s. The first device used 

IoT technology for turning on and off remotely over the Internet 

was a cake toaster. In 2000, the giant company of LG made a 

smart refrigerator that has its capability to determine whether or 

not to replenish the food items stored [5]. Those make the IoT 

gaining significant interest from researchers due to its potential 

for information processing and data exchange in various aspects 

of our everyday life. Now, in around 20 years since Kevin Ashton 

introduced the IoT in a United Nations ITU report [6], the IoT 

became capable of intelligently monitoring, managing, tracking, 

or positioning some particular system. IoT technology is a 

concept in which the device can transfer data over an internet 

network without requiring human-and- computer interaction. In 

other words, the user (human) does not need to control or monitor 

an object or device directly by their hand. The control and 

monitoring process can be done remotely via a smartphone, PC, 

or laptop. 

 

Recently, IoT has been widely used in many topics; some of them 

are in smart shopping system [7], for saving electrical energy [8], 

for school attendance system [9], etc. IoT has been also 

considerably used in the field of small-scale electric power such 

as the Pico hydro power plant. Pico hydro is one of the alternative 

energy sources with relatively small potential energy that can be 

used to provide electrical energy in remote areas. As conducted 

by [10], the authors deal with the IoT in order to measure the level 

as well as the flow of water in the pico hydro power generation 

system. Another development has been proposed by Moreno et 

al. [11], which focused on a web-based data acquisition platform 

integrated with IoT techniques to retrieve data of river water 

levels through cellular networks. Kafli and Isa [12] have also been 

developed a water surface IoT-based monitoring system. Their 

platform was capable to monitor the air quality and water quality 

of a river as well as the water level of the river. As with the shift 

of the turbine shaft, over-speed, and changes in frequency, each 

failure has a major impact on the economy because of lost 

productive hours as well as working hours. As mentioned in [13] 

and [14], the Pico hydro power plant requires a governing system 

to limit the variation of water turbine speed due to the weather 

change and variation of consumer load. Accordingly, it needs a 

system that capable to monitor the river flow speed remotely 

based on IoT. 

METHOD 

The main focus of this study is design and build pico hydro and 

the addition of a monitoring system based on IoT for the output 

of the PLTPH, namely the value of current, voltage, power. 

Requirements analysis in the design of this system includes 

software, hardware, and supporting hardware requirements. 

Need Analysis 

Software Requirements Analysis. The software specifications 

used in this design are as follows: 

1) Operating system used: windows 2007 

2) Applications used to program Arduino: 

3) Arduino IDE 1.8.12. 

4) Software for creating applications: MIT App Inventor 

5) Software to scan QR code : MIT App Inventor 2 

 

Next, analysis of hardware requirements to create a system is as 

follows: 

1) Laptops 

2) Arduino Uno 

3) INA219 sensor 

4) NodeMCU ESP8266 

 

The last one, analysis of other hardware support needs is as 

follows: 

1) Generators 

2) Solar Charge Controllers 

3) Accumulator 

4) Inverter 

5) Lights 

 

Design of Hardware 

The design of a pico hydro power plant through Figure 3.1 is as 

follows. Block diagram are used to facilitate the design of the 

input, process and output sections in this study. The working 

principle of this Pico Hydro Power Plant Simulation is that water 
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flows into the reservoir and reaches a minimum height. Water will 

flow through the pipe which is pumped through the AC pump and 

then channeled to the turbine via the DC pump and drives the 

Pelton turbine. Then when the turbine rotates and causes the 

generator rotor to also rotate so as to convert mechanical energy 

into electrical energy. The output of the generator is stabilized 

with a solar charge controller. Electricity is stored in the battery, 

from the battery the electric current is converted which is initially 

DC to AC current using an inverter which can be used to turn on 

the lights, then sensor data generated from the generator output is 

sent through the IoT process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1. Diagram Block of the Proposed System 

 

The digital data collected is then sent to the Arduino as 

microcontroller. Arduino will calculates the data and then sends 

it to the Node MCU as IoT module. The IoT module is a self-

contained SoC (system on chip) with an integrated TCP/IP 

protocol that has the capability to connect to the internet network. 

This module will continuously send the data over the internet to 

the webserver. All the electronic components in the system are 

powered by the independent power supply that has a battery and 

portable solar cell for self-charging. Meanwhile, Figure 2 shows 

a wiring diagram of all components used in the monitoring system 

of this study.  

 

 
Figure 2. Wiring Diagram of the Proposed System 

 

Electrical design, namely assembling from the output of the 

generator to the charge controller then to the battery, after to the 

battery, namely to the inverter to be changed from DC current to 

AC current then to switches and lights. 

 

 
Figure 3. Wiring Electrical of the Proposed System 

 

Next the process of installing the components of the pico-hydro 

power plant simulation begins with the installation of angle iron 

to form a rectangular table measuring 100cm x 50cm x 100cm 

and installation of the turbine housing, stands for the turbine axle 

and generator, then installation of the water flow path 

 

Figure 4. Design of Mechanical Components 

 

Information: 

1. Generator 

2. Panel Box 

3. Switching and Stop Contact 

4. Light 

5. PVC Pipe 

6. Turbine House 

7. Bearings 

8. Wooden Board 

9. Water Reservoir 

10. Iron Elbow 

Design of Software 

Design Board of NodeMCU and INA219 

So that NodeMCU and INA219 can be programmed and uploaded 

with Arduino IDE software, it is necessary to install the library 

board from NodeMCU and INA219: 

1. Open the Arduino IDE Software. 

2. Then go to File > Preferences. 

Node MCU 

Application 

Water Flow 

Turbine 

Arduino 

INA219 

Generator 

Power Supply 

Supply 

IoT System 
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3. After the Preferences tab opens, enter the following link 
(“http://arduino.esp8266.com/stable/package_esp8266co

m_ind ex.json” ) to the “Addtional Board Manager 

URLs” section. 

4. Enter the Board Manager (Tools> Board > Boards 

Manager). 

5. Type "NodeMCU ESP8266" and INA219 in the search 

then install the board. 

6. After that the Arduino IDE software can be used to 

program NodeMCU and INA219. 

 

 
Figure 5. Additional Board Manager Board URL 

 

7. Enter the Board Manager (Tools> Board > Boards 

Manager), as shown below: 

 

Figure 6. View of Board Manager Board 

 

8. Type "NodeMCU ESP8266" and INA219 in the 

search then install the board, as shown in Figure 5. 
9. After that the Arduino IDE software can be used to 

program NodeMCU and INA219. 

 

 

Design of Android Application Programming 

To create an android application that can monitor value data in 

the form of voltage, current and power, a platform is needed to 

create an android application, namely using MIT App Inventor: 

1. Open a browser then enter the following link: 

https://appinventor.mit.edu/  

2. After entering, click Create Apps! 

3. Then sign in with a google account 

4. After that, enter the application creation page by clicking 

"New Project". 

Figure 7.. Preview MITApp Inventor 

 

5. Then set the design as desired 

 

 
Figure 8. Project View for Android Application 

 

6. Then for programming using block diagram 

programming to go to the programming page click blocks 

in the upper right corner, here is the block programming 

display as shown in Figure 8 below: 

Figure 9. Display of Programming Block 

 

After that, to export the application that has been made, click 

build then scan the QR code, following is the QR code display on 

MIT App Inventor. 

 

https://appinventor.mit.edu/
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Figure 10. Display of QR Code 

 

This section will discuss the testing stage that should be 

conducted in order to ensure the water flow monitoring device 

may function as designed. In the development of software code, 

there is actually a debugging process. This debugging process is 

conducted to detect firstly and then subsequently remove the 

potential errors found in software code. The process is normally 

done by eliminating the language error or syntax error, the run-

time error, and the logical error [15].  

RESULTS AND DISCUSSION 

Testing is carried out after the tool design is implemented with 

the aim of knowing and analyzing the success rate of a pico-hydro 

power plant. Besides that, testing is done to find out the 

weaknesses and limitations of the system that has been made. 

This is done to find out about the performance and function of the 

tool so that it can be used optimally. This section will discuss the 

testing was carried out to determine the output of the pico hydro 

power plant simulation.  

 

In this test, two water pumps were used, namely an AC water 

pump and a DC water pump. The test used a 220 Volt PLN 

electricity source for the water pump source. The test starts with 

the water in the reservoir, then the pump plug is first installed in 

the socket that has been connected in series with the switch, then 

the pump is activated by pressing the switch. After that the AC 

and DC pumps will run. The AC pump will pump water from the 

reservoir to the DC pump, then the DC pump will flow the water 

to the turbine so that the turbine will rotate and activate the 

generator. The electricity generated by the generator will be 

adjusted first before entering the battery through the solar charge 

controller. The output voltage on the battery is in the form of DC 

electricity and then converted to AC electricity using an inverter. 

The output of the inverter enters the switch and is connected in 

series to the socket. The switch is activated to know the sensor 

data to be sent to Arduino and NodeMCU. The data from the 

sensor is current, voltage, and output power from the generator. 

The output of the generator will be processed on Arduino as a 

microcontroller then the data will be sent to NodeMCU via the 

Wi-Fi network and the results will be read in the application that 

has been made on the mobile phone. 

 

The first test carried out in this design is a test of the generator 

output. The goal is to find out the output of the generator to be 

utilized in the generation system. The generator in the pico hydro 

power generation system that is made can work properly. The 

generator can provide electrical energy output to charge the 

battery and the results can be read on the charger controller. The 

output of the generator at the pico hydro power plant produces an 

average voltage of 15.9 Volt, an average current of 50.2 mA. The 

overall summary of the current, voltage and speed data from the 

generator output can be seen in Table 1 below. 

 

Table 1. Data Result of Output Generator 

Testing 

(Minute-) 

Voltage 

(Volt) 

Current 

(mA) 

Speed 

(Rpm) 

Power 

(mW) 

1 16.3 50.7 313.65 826.41 

2 16.3 43.0 307.67 700.90 

3 16.2 47.0 307.20 761.40 

4 15.0 50.7 307.98 750.00 

5 16.3 42.0 305.14 672.00 

6 15.0 52.0 316.14 780.00 

7 16.4 50.0 314.94 780.00 

8 16.4 44.0 303.06 721.60 

9 16.0 50.0 306.12 800.00 

10 16.0 44.0 306.12 704.00 

Average 15.9 50.2 308.802 749.631 

 

Based on Table 1, the generator produces an average voltage of 

15.9 Volt with the largest voltage output being 16.4 Volt and the 

smallest being 15 Volts. The output voltage on the generator tends 

to be stable. The average generator output current is 50.2 mA with 

the highest current being 52 mA and the lowest current being 42 

mA. The output current on the generator tends to be stable. In 

testing the measurement of the output of the generator is carried 

out 10 times every 1 minute with the aim of whether the output 

of the generator for voltage and current will be stable. 

 

 
Figure 11. Generator Voltage and Current Measurement 

 

The next test is testing the INA291 sensor data which is read on 

the android application. This test was carried out using a power 

supply as power with an output of 12 Volts DC and a mini fan as 

a load with a voltage specification of 12 Volts DC and a current 

of 0.15A. The following data has been read on the Android 

application: 

 

Table 2. Data on Application Android 

Testing 

(Minute-) 

Voltage 

(Volt) 

Current 

(mA) 

Power (mW) 

1 16.0 50.7 811.2 

2 16.0 49.0 784.0 

3 16.0 47.0 708.0 

4 15.0 46.0 690.0 

5 16.0 42.0 672.0 

6 15.0 52.0 780.0 

7 16.4 50.0 820.0 

8 16.4 44.0 721.6 

9 16.0 49.0 784.0 

10 16.0 44.0 704.0 

Average 15.88 47.3 747.48 
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The next test is testing the data that goes into Google Firebase. 

This test aims to find out the sensor value data sent to Google 

Firebase and compare the sensor value data from the application, 

following on the Table 3 which is the result of data testing on 

Google Firebase: 

 

Table 3. Data on Google Firebase 
Testing 

(Minute-) 

Voltage 

(Volt) 

Current 

(mA) 

Power (mW) 

1 16.0 50.7 811.2 

2 16.0 49.0 784.0 

3 15.0 47.0 705.0 

4 15.0 46.0 690.0 

5 16.0 42.0 672.0 

6 15.0 52.0 780.0 

7 16.4 50.0 820.0 

8 16.4 44.0 721.6 

9 16.0 49.0 784.0 

10 16.0 44.0 704.0 

Average 15.78 47.3 747.18 

 

Data testing on google firebase was carried out ten times. This 

treatment is also the same as testing the data that appears on the 

android application. The data sent from both google firebase and 

the android application is accurate or exactly the same. 

 

 
Figure 12. Display of Google Firebase 

CONCLUSIONS 

The conclusion drawn from the design of a pico-hydro power 

plant accompanied by an IoT-based monitoring system is that the 

PLTPH that has been made works well as evidenced by a stable 

and constant turbine rotation. The selection of the pump and the 

calculation of the flowing water discharge greatly affect the 

turbine speed. This tool uses a 12-24 Volt DC generator, produces 

DC electricity which is stored in a 12 Volt 5 Ah battery which is 

then converted using an inverter to become AC electricity. In this 

test using the battery voltage which was initially 12.6 Volt was 

reduced to 9.9 Volt, the lamp load was able to light up for 1 hour. 

In measuring the voltage and current, the generator produces an 

average voltage of 15.9 Volt and a current of 50.2 mA, with an 

average generated power of 749.631 mW. Even in the Android 

application and Google Firebase, the value is not much different, 

the average voltage is 15.88 Volt (Android); 15.78 Volt 

(firebase), the average current rating is 47.3 mA, and the average 

power rating is 747.48 mW (android); 747.18 (firebase). 
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